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Knowledge is of two kinds: we know a subject ourselves, or we know where we can find information upon it.
—Samuel Johnson

Abstract
The vast amount of information on the SAS System, particularly that available through the web, can be overwhelming.
Knowing where to find the information you need saves time and frustration. This paper is about the variety of information
and media available and describes where to learn more about SAS.

Introduction
Not having the information you need when you need it leaves you wanting. Not knowing where to look for
that information leaves you powerless. In a society where information is king, none of us can afford that.
—Lois Horowitz
Information about SAS comes from many sources and is contributed by many people, including SAS professional writers,
SAS developers, conference presenters, those with their own web sites, and people asking and replying to questions on
SAS-L, the electronic discussion group.
Throughout this paper, we refer to papers from conferences and information located at the SAS Institute’s web site. See
the section “Users Groups” on how to access conference papers and the sections “SAS Customer Support Center” and
“Resources on the Web” on how to access and browse SAS and other web sites.
Using RESOURCES as an acrostic, we have divided this paper into these nine sections:
R – Regular Books
E – Education
S – SAS Customer Support Center
O – OnlineDoc and SAS Help
U – Users Groups
R – Resources on the Web
C – Comp.sys-soft.sas (SAS-L)
E – Experience
S – Sample Code
Wherever web sites are referenced in the paper, you will be able to click on the underlined name to link to the site.
(The screen shots listed in this paper are the way the web site looked when this paper was written. Remember that the
look and feel of the site may have changed. Do a search if a site referred to in this or other papers is no longer available. )

Regular Books
The man who does not read good books has no advantage over the man who cannot read them. —Mark Twain
Let’s begin with regular books, that is, printed material.
“What was the last computer book you purchased? Why? What is your favorite all time computer book? Why?” These
questions appear as potential interview questions in the SUGI 25 paper “The Ultimate Match Merge: Hiring the Best SAS
Programmers”. Answers to these questions could indicate to the interviewer whether or not you are willing to invest in
learning more and keeping up with your profession.
Books may seem expensive compared to getting information from the web for free. However, consider the time saved by
referencing the needed information concisely and thoroughly presented in a book versus spending literally hours
searching the web for information. In particular, you will save yourself time and frustration when you find and use those
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books that teach you how to use a specific tool, such as macros or Output Delivery System. The books often have useful
examples with explanations.
SAS Titles. SAS Publishing produces books written by SAS staff. In 1976 there was one SAS manual, A User's Guide to
SAS 76. It consisted of 330 pages and documented the 33 procedures in SAS 76. In 1996, there were more than 340
manuals and more than 100,000 pages. A quick calculation indicates that both the number of manuals and total pages
doubled about every 2½ years.
Fortunately, many of the SAS titles are available for free as part of SAS OnlineDoc. Both an HTML-based online library
and a PDF version of the online library are accessible at support.sas.com/documentation/onlinedoc/. See the “OnlineDoc
and SAS Help” section of this paper for information about SAS OnlineDoc. Many getting-started type books and example
type books are not included in SAS OnlineDoc.
SAS Publishing has produced an excellent book for beginning and intermediate programmers called Step-by-Step
®
Programming with Base SAS Software. It is a how-to guide on using DATA step programming and base SAS procedures
with many examples and explanations. This book can be purchased as a regular book. Also SAS OnlineDoc 9 contains
®
the title Step-by-Step Programming with Base SAS Software.
To order books online and track your order, visit the SAS Publishing page at the SAS Customer Support Center site
(support.sas.com/publishing.) Click on SAS Publishing in the right sidebar. Here you will find the bookstore. You can
search for topics and get the book’s description, price and other items, such as the book’s table of content, a sample
chapter and SAS code used in the book. You can read book reviews and browse information about the authors.
Books By Users. BBU books are written by SAS users, and published by SAS Publishing. There are more than 75 BBU
books. They cover a variety of topics, including SAS applications and examples. BBU books run the gamut from beginning
books to those on specific topics, such as using SAS with health care. The book Little SAS Book: A Primer, which is
shipped with installation material, is a BBU book. A BBU book can be a time-saver. For example, the BBU book, Your
Guide to Survey Research Using the SAS System gives code and information about analyzing the results of a survey and
producing graphs.
If you like to learn by example, many of the BBU books are written in that format, such as Proc Tabulate By Example or
Cody's Data Cleaning Techniques Using SAS Software.
SAS.COM. Subscribe to the Institute’s free quarterly print magazine or read it online. To subscribe, you must logon to
your SAS Profile. To register, click on MY PROFILE in the upper right corner of the SAS Home page (www.sas.com.)
There you can manage your subscriptions and also view white papers on specific technologies.
Other Computer Books. The SUGI 27 paper “10 Things Experienced SAS® Programmers Don’t Know – But Should”
lists the results of an informal survey regarding the most important skills needed by experienced SAS programmers.
Knowledge of system development life cycle processes was mentioned as important with a reference to the outstanding
book Code Complete: A Practical Handbook of Software Construction by Steve McConnell, Microsoft Press (1993.)
Also consider general computer books and books specific to your industry. Browse your local bookstore, your local
college library, your company library, and online for useful computer books. The online bookstores usually have reviews of
the books by readers. Amazon.com sells SAS books by other publishers and some books published by SAS Institute.
Which Books Will Be Useful To You? One way to decide which books will be useful to you is to browse the books in the
publications area of the Demo Area at the regional and SAS international conferences. Another way is to visit the
bookstore of SAS Publishing.

Education
A man will be imprisoned in a room with a door that's unlocked and opens inwards; as long as it does not occur
to him to pull rather than push. — Ludwig Wittgenstein
SAS Training, available in many formats and delivery methods, is available from SAS Institute and other sources. Visit
Training at the SAS Customer Support Center site (support.sas.com/training) for the most current information about
training and courses offered by the Institute. You may also want to subscribe to EDUmation, a monthly electronic
newsletter that is free and contains news about the latest on training, certification and special offers for subscribers. Go to
support.sas.com/training/news for instructions on subscribing.
Here are some of the training delivery methods offered by SAS Institute.
Instructor-based courses. SAS Institute instructor-based courses are offered in many cities and before and after the
SUGI conference. The Course Notes that you receive in the course are also sold at SAS Publishing on the SAS site.
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e-Learning. SAS e-Learning allows you to take SAS Institute professional training from your desktop. SAS Institute offers
two forms of e-Learning, self-paced courses and live web classes. Self-paced e-Learning courses are affordable and
there are even some free courses such as Getting Started with SAS and Getting Started with SAS Enterprise Guide. Selfpaced e-Learning courses are taken in conjunction with the SAS software and include interactive questions and quizzes
and guided exercises so that you can practice as you learn. There are self-paced e-Learning for individuals and for
organizations. Live web classes are taken using a web browser and telephone from your desktop. In real time, you can
interact with the SAS instructor and fellow students.
SAS Learning Edition. The SAS Learning Edition is a package that provides a hands-on experience way to learn SAS,
particularly for students at educational institutions. It includes educational software (valid through December 2008), an
Enterprise Guide tutorial, online help, and a turnkey customized installation. Go to the Bookstore section of SAS
Publishing and search for “Learning Edition” for information about this package and its cost.
SAS Certification Professional Program. SAS Institute has a global certification program. One way to prepare for the
certification exams is the SAS Certification: Base Programmer and Advanced Programmer e-Learning courses that can
be licensed from the Institute. For information, visit support.sas.com/certification. Click on Training & Preparation in the
right sidebar.
Getting Started with SAS Software. The drop-down menu of SAS System Help points to the “Getting Started“ tutorial,
which has hands-on experience using SAS software. This same tutorial is available at the SAS site. Select Training→Elearning and then click on Free Tutorials on the right side of the page.
UCLA Learning Module. Check out the SAS Learning Modules from UCLA Academic Technology Services at
www.ats.ucla.edu/stat/sas/modules/default.htm.
SAS Users Groups. Hands-on workshops and pre/post conference training are offered at the regional conferences and
at the SUGI conference. Sunday Seminars and Wednesday Afternoon Seminar on a variety of topics are offered for a fee
before and after the SUGI conference. Local users groups usually offer training at their meetings.
Other Vendors Training. Other vendors offer training on SAS. You may see them advertising in users group newsletters,
offering training at regional conferences, and staffing booths in the conference demo area.
Efficient Ways to Learn SAS. The SESUG paper “Efficient Way to Learn SAS® with Virtually No Cost” provides a list of
web resources for learning SAS and is at www.rtpnet.org/~rtsug/Finalpaper.doc. Just click on the link in the paper to go
directly to the site listed or cut and paste the link to your web browser.

SAS Customer Support Center
SAS Institute’s Web Site. SAS Institute’s site is both for those who are interested in learning about the SAS products
and for those who are already using SAS software. The home page is located at www.sas.com.
As a user of SAS software, you will want to visit the SAS Support Center. Either go to support.sas.com or choose Support
and Training or SAS User at www.sas.com. Next, you will see the following screen. You will want to become familiar with
what is available by visiting the topics listed in the bar on the left of the screen.

For more information, see the SUGI 27 paper “Tips, Downloads, Samples, and Training – Discover the Service and
Support Web Site”.
Technical Support. One of your primary areas of interest will be the pages listed by clicking Technical Support. The first
place to visit there is Top Ten Ways to Use Our Web Site. How to contact Technical Support explains that you can do an
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online problem or question submission or contact them by phone. You will be asked for your site or customer number,
which is displayed in the log when you first start the SAS System.
Become familiar with searching for information in the individual knowledgebases.

The SAS knowledge databases, known as SAS Notes, contain information on known problems, fixes, documentation
errors and corrections, usage issues and tips.
Technical Support Documents provide helpful information. You will find some gems here. For example, TS-664 A DATA
Stepper’s Introduction to ODS gives examples of using ODS in the DATA step. TS-722, entitled Marketing Research
Methods is a recent addition and consists of 857 pages. TS-722I is the Experimental Design and Choice Modeling
Macros used in the document.
Browse the index by number or category and review the titles of all the documents. Once you get to the index page, there
is a dialog box so that you can search all technical documents.

Documentation. SAS Publishing is located under the topic Documentation. Here you can subscribe to SAS Institute's enewsletters Your SAS Business Report and Your SAS Technology Report, which are delivered on alternating Tuesdays.
You can quickly read the few entries in the e-mail and select the links to articles of interest on the SAS web site.
On the Documentation page, you will find a link to White Papers. The IT industry uses the term “white paper” to describe
articles that explain and promote the benefits of particular technologies and products. SAS Institute has white papers on a
variety of topics. For example, if you are interested in learning about the capabilities of SAS Enterprise Guide, there is a
®
white paper entitled “SAS Enterprise Guide — A Roadmap”. In order to access the white papers, you must first log in. If
you do not already have a profile, there is a link to the form to create one.
Communities Be sure to explore the Communities. It is a collection of information about a common area, such as Base
SAS or Web Technologies. Here’s where you will find information on new and experimental products and solutions. If you
are interested in ODS, the Output Delivery System, then go to ODS Resources in the Base SAS Community.
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OnlineDoc and SAS Help
"Joy in looking and comprehending is nature's most beautiful gift." — Albert Einstein
The SAS OnlineDoc is an online reference library that contains more than 70 titles and thousands of pages of reference
documentation. The documentation would cost more than two thousand dollars if purchased as individual printed books.
You can access the SAS OnlineDoc from within a SAS session or from the SAS web site for free.
SAS 9 combines online documentation and help into one resource called SAS Help and Documentation. It contains a
complete description of each SAS procedure, along with examples. It contains complete descriptions and examples of the
components of the SAS language, such as, functions, formats, and the macro facility. It includes what’s new in the latest
releases; information on your operating environment and the windowing environment; numerous sample programs; and
more. Only the documentation for the software licensed by your site is installed; thus making it easier to find the
information you need.
SAS Help and Documentation is accessed from within a SAS session by selecting the Help drop-down menu.

The Help drop-down menu in SAS 9 also includes: Using This Window (information about the currently selected window),
Getting Started with SAS Software (quick-start tutorial for new SAS programmer and resource tutorial for experienced
SAS programmer), Learning SAS Programming (if you license SAS online training), SAS on the web (link to
www.sas.com), and About SAS 9 (information about the SAS 9 release on your system.)
Contents Tab. After opening SAS Help and Documentation, click on the Contents tab to see the table of contents. When
you get a new release of SAS, browse the What's New section for new features and enhancements.

Select the +/- sign next to each section to expand/collapse the table of contents. Expand any of the sections of interest to
become familiar with SAS Help and Documentation. By becoming familiar with the layout, it will be easier to find the
information when you are in a hurry.
Here we have expanded some sections to show the location of the documentation for the Base procedures.
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Favorites Tab. If you are on a help page to which you may want to return, then click on the Favorites tab, and click the
add button at the bottom of the panel. The name listed may not be clear or concise. In that case, right mouse click on the
name and rename it. When you open Help again, you will find the favorite topics listed in alphabetical order by the new
names. Therefore, topics that you reference often could be named so that they appear at the top of the listing.
To easily return to a favorite page, click on the Help Favorites tab and double click on the topic in the list of favorites that
you have added. Be generous in adding favorite topics. It is quick and easy to do. Besides, you can always remove topics
that you no longer want.

Index tab. The comprehensive master index is located under the Index tab. If you want to display an index for a specific
keyword, type the keyword in the field. Being able to search the index for a specific keyword saves time.
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Search Tab. Select the Search tab to perform text searching for a specified keyword. Enter the keyword in the find field
and click the List Topics button. Double-click one of the topics found or highlight a topic and click on the Display button at
the bottom. The keyword will be highlighted in the documentation displayed.

Context-sensitive Help. Another way to quickly get to the help documentation from the program editor window is to use
the context-sensitive help feature. Context-sensitive help is activated by pressing the Help key, usually F1, and it displays
the help documentation for the subject where your present cursor position is located. Here’s an example of how to use it.
Put your cursor on a PROC name in the program editor and press F1 to go directly to the help for that procedure. For
example, you are in the editor window and have typed PROC TABULATE and cannot remember the syntax. Put your
cursor on TABULATE and press the F1 (help) key. Up pops the help window for that procedure.
Help Command. On the command line, you can type the word help followed by a topic.
Using This Window. One of the menu items in the Help drop down menu is Using This Window. Click on this item to find
out information about your currently active window. This is helpful for finding out features about commonly used windows
and learning how to use a new window, such as the Query window or Graph-N-Go window.
SAS OnlineDoc at the SAS Web site. HTML-based SAS OnlineDocs for version 8 and higher are available under
Documentation at the SAS site (support.sas.com/documentation/.) You can reach the printer-friendly PDF version of the
SAS reference library 9.1 online from this location. Use the PDF version to print selected pages or entire books. You can
also read and download from the PDF version.
SAS OnlineDoc 9.1 for the Web CD-ROM. This can be installed on a web server in most Windows and Unix
environments. The same SAS titles are accessible that are accessible from within a SAS session. The advantage is that
you can access the documentation without opening your SAS session.
SAS OnlineDoc CD-ROM for the Windows Desktop. The SAS OnlineDoc 9 CD-ROM for the Windows desktop is
available for purchase from SAS Publishing at support.sas.com/publishing/.

Users Groups
None of us is as smart as all of us. —Anonymous
SAS conferences offer numerous benefits, such as a place to talk with your peers, exchange ideas, attend papers on
topics of interest to you and talk to SAS staff in the demo areas. They also offer hands-on workshops and pre/post
conference training. Go to the topics under Users Groups on the right bar on the SAS Customer Support Center page to
find out more about local, regional, international, and special interest users groups and conferences.
The conference Proceedings is a compilation of the papers and posters given at the conference. If you attend the SAS
International Users Group (SUGI), you will get a CD-ROM version of the Proceedings. It usually has the current and the
two previous conference Proceedings.
The SUGI Proceedings, beginning with SUGI 22, are located at the SAS web site.
To get to the SUGI Proceedings online, choose SUGI under Users Groups and then Online Proceedings. Here you can
search for a topic or go directly to a particular proceedings.
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Regional and Special Interest Groups. NESUG (The NorthEast SAS Regional Users Group) has their proceedings from
1997 to present available online at their web site (www.nesug.org.)
®

PharmaSUG, the Pharmaceutical Industry SAS Users Group (www.pharmasug.org), has their proceedings online since
PharmaSUG 2000
Lex Jansen's web site (www.lexjansen.com) has access to the SUGI, NESUG and PharmaSUG proceedings and
organizes papers by categories. You can also access the SAS-L archives from his site.
Visit the SAS Consultant Special Interest Group (www.sconsig.com) for SAS tips and links to other sites. Go to the
directory at the bottom of the page and click on SAS Web Ring to see other sites with SAS information. Select SAS Tips
and Techniques (www.sconsig.com/sastip.htm) to view over 400 coding tips and techniques. You can even be sent email
when the page changes.
®

®

Notes About the Adobe Reader . You will use the free Adobe Reader from your Web browser to view and print papers
from the Proceedings, which are stored in Adobe PDF (portable document format.) Adobe Acrobat Reader 5 and higher
allows you to select and cut columns of text, which is useful for cutting sample code from SUGI papers with two columns.
Attached to each document is certain security and permission parameters, such as restrictions on printing, copying, or
cutting text from a document. You can view, but not change, the security settings for a PDF file. To view the security
settings of a document open in Adobe, choose File > Document Properties and click the Security tab. To view the security
above the vertical scroll bar on the right side
settings of a document open in a web browser, click on the pop-up menu
of the document. Choose Document Properties and click on the Security tab.

Resources on the Web
“By means of electricity, the world of matter has become a great nerve, vibrating thousand of miles in a breathless
point of time ... The round globe is a vast brain, instinct with intelligence. — Nathaniel Hawthorne, 1851
With so much information now online, it is exceptionally easy to simple dive in and drown. —Alfred Glossbrenner
In his book Information Anxiety, Richard Saul Wurman writes:
If Orwell were writing 1984 today, he would not say, “Destroy the information.” He would say, “Inundate people
with information, they’ll think they’re free. Don’t deny them. Give them more. Undigested information is no
information at all, but it creates the fiction that you have accessed it, even though you didn’t benefit from it.”
On the Web, you are inundated with so much information that it is indeed overwhelming. The Internet is growing so rapidly
that it is difficult to keep up with all the information and services. Therefore, it is useful to know where to look.
Other SAS Resource Sites. Other web sites of interest to SAS programmers are those with collections of documents
about SAS, collections of SAS code, SAS tips and the various sites that demonstrate running SAS programs from the
web. Some of these sites are supported by regional and special interest users groups and can be reached from the SAS
site Users Groups pages. Follow the link to a specific users group and see if there is a link to its web site.
The SUGI 26 Paper “Internet and Web Resources for SAS Programmers and Statisticians”, gives an extensive list of SAS
related web sites. It is divided into categories, such as Consulting, Personal SAS or Statistics Pages, Useful Resources,
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Statistics Resources, and Tutorials And Tips. An updated listing of resources is kept by Wei Cheng at www.prochelp.com.
Use the table of contents listed in the frame on the right of the web page to select a category.

UCLA site: The UCLA site (www.ats.ucla.edu/stat/sas/) lists resources of interest as shown here.

Statistical Sites. Besides links to web pages that perform statistical calculations, the Interactive Statistical Pages
(www.statpages.net) also links to online statistics books, tutorials and related sites. The Electronic Statistics Textbook
(www.statsoft.com/textbook/stathome.html) is an extensive site that gives training on statistical concepts and applications
E-newsletters. SAS Views (www.views-uk.demon.co.uk) is the newsletter of the Independent UK SAS User Group and
offer tips and techniques. Ratcliffe Technical Services web site (http://www.ratcliffe.co.uk/) is another newsletter that offers
hints and tips.
Other Web Sites. The best way to discover what is available on the web is to use a search engine. Well known search
tools are Google (www.google.com), msn Search (search.msn.com) and Yahoo (www.yahoo.com.)
For example, when someone sends you an e-mail or a story that you think is a hoax, check it out by searching for the
relevant information or visit the Urban Legends Reference Pages (www.snopes.com.)
In doing a Google search on the keywords “find data Internet”, we found journalist Robert Niles’ page “Finding Data on the
Internet” (www.robertniles.com/data.) It has links to a number of general interest sites for researchers and journalists and
a link to his page How to Use Math and Statistics. Niles’ simple explanations of basic concepts in statistics might be
helpful when you need to explain one of the concepts to someone else.
Web Skills. When searching, be careful of your time. The web has a lot to offer. At the same time, it can be a time
sponge. You can spend hours reading discussion groups and doing searches. You can find an enormous amount of
information of which only a small portion is useful or you can find some extremely beneficial information. Just remember to
keep your goal in mind and set a mental or actual alarm clock.

9

SUGI 30

Planning, Development and Support

Use your critical thinking skills when finding information on the web. Not all sources on the web are equally valuable or
reliable. When visiting sites while researching this paper, we found resources that were out-of-date or biased.
Remember to bookmark sites of interest, so that you easily find them again. You can also drag an address to the Links
toolbar on your web browser for sites that you visit frequently. See the example under the topic Comp.soft-sys.sas.
You may want to set up a folder of SAS links, such as:

Right mouse click on one of the links and choose properties to find out where the links are stored and where to create the
folder.

Comp.soft-sas.sys (SAS-L)
The more that you read, the more things you will know. The more that you learn, the more places you'll go.
— Dr. Seuss
SAS-L is the electronic users group devoted to the discussion of SAS software and has been in existence since 1986. It is
available as a newsgroup comp.soft-sas.sys and a mailing list. SAS-L is where we learned about UltraEdit®, our favorite
editor.
You can give and receive SAS expertise on the SAS-L discussion group. Once you start reading SAS-L messages, you
will find that there are several SAS experts who consistently assist SAS users with their SAS questions.
There are thousands of people who read the SAS-L messages. Here are three ways to read the messages. You can
subscribe to SAS-L and receive the messages in your mailbox. You can read the messages in the newsgroup through a
newsreader client on your computer. Finally, you can read the messages through the Google Groups web page.
Subscribing to SAS-L. To subscribe to the SAS-L mailing list, send an e-mail message to the address
listserv@uga.cc.uga.edu. In the body of the message, type: SUBSCRIBE SAS-L your name
You may receive each message separately or you may get a daily compilation of the day's messages by sending the list
server the message: SET SAS-L DIGEST.
Newsgroup COMP.SOFT-SYS.SAS. You may want to view the messages via the newsgroup comp.soft-sys.sas. The
advantage is that you don’t have mail coming directly to your mailbox. The disadvantage is that messages on the
newsgroup may be a few hours old.
You can set up a newsreader client on your computer to access this newsgroup.
An easy way to view the newsgroup is to use Google Groups from your Web browser. Go to www.google.com and click
on the Groups tab. It can also be found at groups.google.com. The SAS-L group can be found at:
http://groups-beta.google.com/group/comp.soft-sys.sas.
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Once you have the group messages listed, bookmark it or put it on the Links toolbar of your web browser. With Internet
Explorer and other web browsers, you can drag the address in the Address box to the Links toolbar.

Then shorten the text of the link by right mouse clicking on the text next to the icon and renaming it “SAS-L”. This way you
can quickly call up the SAS-L group by clicking on your newly created link SAS-L.

Searching the SAS-L Archives. The SAS-L archives, a repository of previously sent messages, is a good source of
information to search for answers. You can search the SAS-L archive at: www.listserv.uga.edu/archives/sas-l.html.
Also, you can search the archives at Google. They are maintained back to the first message posted on comp.sys-soft.sas
on July 20, 1993, announcing the creation of the unmoderated newsgroup ”comp.soft-sys.sas The SAS statistics
package.”
You can search all groups or do an Advanced Groups Search and limit the group to comp.soft-sys.sas and fill in other
limits, such as message date. If you are already at the group, you will see the dialog box “Search this group” on the right
side of the page. There are over 175,000 messages in the newsgroup.
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Experience
You make a living by what you get. You make a life by what you give. —Winston Churchill
Seek Out The SAS Expert. You probably know who is the SAS expert at your company and who is willing to answer
questions and help with problems. You can also find out who are the designated local SAS support personnel at your
company. At the SAS Customer Support Center, click on Technical Support→ Explore Services→ SAS Support
Personnel.

You will be emailed the information.
Exchange Ideas. When you feel comfortable using SAS, consider giving back to the SAS community by providing
information to others. Exchange ideas and share expertise with your colleagues and within your organization. Become
involved in the SAS-L discussion group.
Users Group Participation. Get and share information by participating in a users group at the local, regional and/or
International level. The international and regional conferences are planned and organized by SAS users, like you, who
generously donate their time and talents. Volunteers are always needed and essential to the continued success of the
conferences. A partial list of tasks and talents needed is section chairs, session coordinators, speakers, and judges.
Regional conferences also need publication and registration coordinators, registration staff, and coordinators for the
facilities, audio-visuals, special events, and pre and post-conference courses.
So, if you don't want to speak or give a poster, remember that there are many other ways to share your talents, time, and
expertise at a conference.
Your Own Experience. Keep a log of your own SAS experience and SAS code. An online log can contain links to papers
and SAS code.

Sample Code
The limits of my language are the limits of my mind. All I know is what I have words for. — Ludwig Wittgenstein
Examples are an excellent way to learn about a procedure or feature. Examples of SAS code are located in many places.
Usually you just need to select and copy the example into the editor window of your SAS session or your program file,
check that you have any needed data and the libnames and filenames that point to data are correct for your operating
system and then run the code.
Sample Code in SAS Help. You can access the SAS Sample Library from SAS Help in your windowing environment.
After accessing Help in Version 8, click on the Contents tab and then on Sample SAS Programs and Applications. In
Version 9, click on Help on the menu bar, then SAS Help and Documentation. Next click on the Contents tab, Learning to
Use SAS and then on Sample SAS Programs.
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You can select, cut and paste the example into the Editor Window.
If the Sample SAS Programs are not accessible, please ask your SAS Installation Representative for the location of your
local Sample Library or look on the distribution media for the SAS software.
Code Sample at SAS Customer Support Center. The first place to start to find sample code is at the SAS Customer
Support Center. Choose Code Samples from the menu on the left of the home page. You will see this page displayed.

Check out the sample code from SAS Institute and BBU books under Samples Published in SAS Documentation listed on
the above page.
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Samples from SAS Developers Visit the SAS Communities on the SAS site for sample code in the various areas, such
as ODS examples under the Base SAS Community or web-enabled data visualization samples under Data Visualization.
Sample Library. The Version 6.12 Samples Library consists of over 1250 files and can be accessed through SAS
Sample Programs under the Technical Support area at the SAS Customer Support Center.
Examples in SAS OnlineDoc. SAS OnlineDoc has examples for most of the procedures. Usually any needed data are
included with the code. You can see the Results by clicking on the Listing or HTML Results icons listed after the example.
You can compare your results of running the code with the Results listed with the example.
Examples in the Conference Proceedings. Some conference papers include snippets of code or complete examples.
Prior to SUGI 29, the papers in the conference Proceedings are in 2 columns. Adobe Acrobat reader 5 and higher allows
you to select and cut columns of text.
Code Created in SAS Windows. There are a few windows in the Windowing environment that use point and click to
generate results. Some of these windows are Graph-N-Go, the Query window, and Analyst Application. They have the
capability to also save the SAS code that generated the result. You can save the code to review and learn from it or to use
it as a starting point for further development. To learn how to save the code, review the help for the particular active
window by selecting Using this Window from the drop-down help menu.
Code Created in SAS Enterprise Guide. SAS Enterprise Guide is a Windows client application with a point-and-click
graphical interface for reporting, graphing and analysis. As you point-and-click, SAS code is generated in the background.
You can review and save the generated code.
Examples of Code on SAS Resource sites. Some university, personal, and company web sites also have examples of
SAS code. You might have success in finding code by doing a Google search, such as searching for “SAS code
Tabulate”. For example, I found this page:

Though there were Proc Tabulate examples, this code to do the Font-Dump was also found and was useful for a current
project.

Examples of Code Written At Your Company. Don’t forget to review code that is written at your company. You will want
to get your company’s standards, if any, for writing and documenting SAS code.
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Conclusion
Not everything that can be counted counts, and not everything that counts can be counted. — Albert Einstein
Knowing how and where to find the answer, not necessarily knowing the answer, is an important skill for a SAS
programmer to have.
There is a wealth of information about the SAS System ranging from hardcopy books to online discussion groups. This
paper gave an overview of the resources available to help you find the answer. Spend some time to become familiar with
the many SAS resources. Then when you are pressed for time on a project, you will feel more confident in being able to
use SAS resources to find answers.
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